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Chapter 1: Installation & Registration

1.1 Introduction

Lizard Safeguard Secure PDF Viewer enables you to view protected PDF files
that have been published in .PDC format.

Safeguard Viewer is a standalone application that controls what you can do
with protected PDF files (for example how long you can view them for, whether
you can print them, etc.). These document controls are set by the publisher of
the document and cannot be altered by yourself.

All trademarks of Adobe Systems Incorporated are acknowledged, as are any

other trademarks referenced in this manual.

1.2 Installation Pre-requisites

NOTE: Mac Installs

This manual only covers the installation of Safeguard Viewer on Windows platforms.
For installation of Safeguard Viewer on Macintosh computers please refer to the Lizard
Safeguard Macintosh OS X manual.

Safeguard viewer is compatible with the following Windows platforms:

e Windows 2000
e Windows 2003
e Windows XP

e Windows Vista
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1.3

IMPORTANT NOTE: Installation Rights

You need to have Windows Admin rights to install the viewer software AND to register a
license. If you don't have Windows Admin rights then you cannot install the viewer or
register a license. Once the viewer software has been installed and the license has been
registered, then non-administrative users can login to view protected documents.

Please bear in mind that the keystore files are written to the All Users area of the

computer and are therefore available to all users of that computer.

Installing the Viewer

Double-click on the SafeguardPDFViewer.exe file in Windows Explorer to start

the installation process. The installation process is straight-forward and it takes

less than a minute from start to finish.

Screenshots of the installation process are given below and are self-

explanatory.

15 Setup - Lizard Safeguard - PDF Viewer [ = =)

Lizard Safeguard Welcome to the Lizard Safeguard
e =Y/ R\V/s=l - PDF Viewer Setup Wizard

This will install Lizard Safeguard - POF Viewer 2.5.92 on your
computer.

It is recommended that you close all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

<o lockLizard

[ MNed> |[ Cancesl

Diagram 1: Safeguard Viewer Setup Wizard
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45 Setup - Lizard Safeguard - PDF Viewer [=lle =
License

Please read the following impartant information before continuing. lockiizard

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

LOCKLIZARD END USER LIMITED LICENSE AGREEMENT -

GENERAL

This license agreement is the contract between LockLizard Limited
(LockLizard), a company registered in England and Wales No.
5117542 and any person or entity that is making use of a

LockLizard product for the purpose of using files compliant with <z

() | accept the agreement
@) | do not accept the agreement

et

Diagram 2: License agreement

45 Setup - Lizard Safeguard - PDF Viewer [=lle =

Select Destination Location

) R i 7
Where should Lizard Safequard - PDF Viewer be installed? LockLizard

, Setup will install Lizard Safeguard - PDF Viewer into the following folder.

To continue, click Mext. f you would like to select a different folder, click Browse.

C:M\Program FilesLizard Safeguard PDF Viewer Browse...

At least 13.0 ME of free disk space is required.

[ <Back |[ Ned> | [ Cancel

Diagram 3: Safeguard Viewer Installation folder

45 Setup - Lizard Safeguard - PDF Viewer (=] & =

Select Start Menu Folder

Where should Setup place th s shortcuts?
ere shou up place the program’s shortcuts \ockiizard

, Setup will create the program’s shortcuts in the following Start Menu folder.

To continue, click Mext. f you would like to select a different folder, click Browse.

LockLizard'\Lizard Safeguard ' PDF Viewer Browse...

[ <Back |[ Ned> | [ Cancel

Diagram 4: Safeguard Viewer Installation Settings
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15 setup - Lizard Safeguard - PDF Viewer == Eoh =
Ready to Install
Setup is now ready to begin installing Lizard Safeguard - PDF Viewer on your

computer. LockLizard

Click Install to continue with the installation, or click Back if you wart to review or
change any settings.

Destination location: -
C:\Program Files'\Lizard Safeguard PDF Viewer

Start Menu folder:
LockLizard'Lizard Safeguard ' PDF Viewer

[ <Back |[ mstal | [ Cancel

Diagram 5: Safeguard Viewer Installation Confirmation

== == |
Lizard Safeguard Completing the Lizard Safeguard -

(I=ImRV\V/u=3 PDF Viewer Setup Wizard

15 Setup - Lizard Safeguard - PDF Viewer

Setup has finished installing Lizard Safeguard - PDF Viewer on
your computer. The application may be launched by selecting
the installed icons.

Click Finish to exit Setup.

lol:klizarll

Diagram 6: Safeguard Viewer Installation complete
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1.3.1 Firewall messages displayed during installation

During installation your firewall or anti-virus software may prompt you with

the following (or similar) message window.

r !

“ ~  SUSPICIOUS BEHAVIOR

is-HVO4T.tmp may be trying to prevent
'HKLD" from running each time your
computer is started by modifying the
reqistry key:
HKLM\SOFTWARE\MICROSOFTWINDOW
S\CURRENTVERSION\RUN

Application: iz-HY 04T trp
Wiew Properties

SmantDefense Advisor

? SmartDefenze Advizar iz nat available for this
alert type.

r Apply thiz zetting to all suspicious behaviorz
exhibited by this application

[ Al ] [ iDery i ]

N

Diagram 7: Firewall message window during installation

L

During installation Safeguard Viewer prevents the process HKLD.exe from

running which was used in previous versions of the Safeguard Viewer.

Check the box and select allow (or the equivalent for your product).
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1.3.2 Silent (remote) Installation

In corporate environments it may be a requirement that your IT department
install applications programs and not you as the user.

Corporate IT departments often use system administration programs to
remotely install software onto the desktop. These tools often do not
process messages that an end user would have done because they will use
all the default settings for the system. To support IT department
deployment we provide a silent installation mode to facilitate their ability to
carry out automatic installs. As an end user you might also wish to use this
facility in order to save time.

To run Safeguard viewer in silent installation mode without any dialogs
displaying, the setup must be launched using the Windows Run command
and the "/VERYSILENT" parameter.

Example of use: SafeguardPDFViewer_v25.exe /VERYSILENT

Alternatively, if you would like the installation progress window to be
displayed but none of the other dialogs (wizard and background window)
then you can run Safeguard viewer with the "/SILENT" parameter.

Example of use: SafeguardPDFViewer_v25.exe /SILENT
NOTE: Path Name

From the Windows Run command you will need to specify the path of the exe file, so
the example above might be entered as follows:

"C:\Downloads\SafeguardPDFViewer_v25.exe" /silent

1.3.3 License File Registration (silent mode)

Once the viewer software has been installed in silent installation mode, you
can register a license file from the command line (Windows Run command).

Example of use: PDCViewer.exe "C:\Licensefiles\YourName.llv" "/silent"
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1.3.4

1.3.5

IMPORTANT NOTE: Internet connection required

The license file will be registered with the LockLizard Administration server so an
Internet connection is required, unless you have purchased LockLizard Safeguard as an
own server solution running on your Intranet. You must have Windows Admin rights in

order to register a license.

MSI Package

Safeguard viewer is also available as an MSI package so you can deploy it
using Group Policy in your Windows enterprise environment.

The MSI package can be downloaded from the LockLizard web site:
http://www.locklizard.com/Downloads/SafeguardPDFViewer v25.msi

Disabling Automatic Updates

You may want to disable the auto update checker from running if your users
are in a "locked-down" network environment and cannot install any
software on their desktops. In such an environment, if a regular user
attempts to update the viewer software then they will receive an error when
the installation fails since the viewer software is unable to update the
Windows registry.

Example of use - disable automatic update checks:
SafeguardPDFViewer_v26.exe /UPDATE="0"

Example of use - enable automatic update checks:
SafeguardPDFViewer_v26.exe /UPDATE="1"

NOTE: Manual Program Checks

Even if automatic update checks are disabled users can still manually check for updates
using the ‘Check for Program Updates’ option on the Help menu.
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1.4

Managing Proxy Settings

Proxy servers are used in some organizations to change the port addressing
from the Windows default to another internally determined port number.

On some systems, because of internal security requirements, firewall controls
are set to prevent internal applications from connecting directly to external
web addresses. Further, to help prevent attacks from hackers, and prevent
keyloggers and other programs commonly used by hackers, viruses and worms
to send confidential internal data to outsiders, internal systems may use port
addresses on the firewall that are not the standard ports. Finally, the firewall
may require users who wish to use external services to authenticate
themselves to the firewall before they are able to use external services.

To support these higher security requirements, Safeguard Viewer allows you to
configure your proxy settings into the viewer.

Safeguard Viewer will automatically pick up current proxy information from
Internet Explorer if it is available. However, if your proxy requires
authentication, a dialog box will be displayed where you must enter the user
name and password needed to authenticate yourself to the proxy.

Connect to 192.168.0.142 x|

A \L\"‘-

" 0.

CCProsey Authorization

User name: I ﬁ Iserl j
Passwiord: IE

¥ Remember my password

Ik [ I Cancel

Diagram 8: Proxy authentication dialog
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Your internal IT department should be able to provide you with the necessary
information.

There may be circumstances when you need to manually override these
settings before you can register and use the viewer software.

To manually configure proxy settings right click on the Windows Start menu and
select Programs > Lizard Safeguard PDF Viewer > Proxy Settings.

The following dialog is displayed.

@ Lizard Safeguard Viewer proxy settings @I

Automatic configuration script (%.js, *.jvs or *.pac file)

Address;

Proxy server

[Tu=e Proxy

Proxy authentication

o ][ cn |

<=5 LockLizard

Diagram 9: Proxy settings dialog

This dialog enables you to set the proxy from a configuration script or by
manual entry.

1.4.1 Automatic configuration script

The viewer can be configured using a proxy administration PROXY.PAC file (a
plain text file containing a JS function that will automatically configure the
proxy settings to be used). In the ‘Address’ field, type in the full path of the
Proxy.pac file you want to use (either an http:// path or a local file) and then

Load

press the button.
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Below is an example proxy.pac configuration file that will make the viewer

(or Internet Explorer) go via a local proxy server if a connection is made to

www.locklizard.com:

function FindProxyForURL(url, host)

{
if (shExpMatch(url, "http://www.locklizard.com*"))

return "PROXY 192.168.1.1:8080";
else

return "DIRECT";

1.4.2 Proxy server manual entry settings

To manually enter proxy settings, check the ‘Use proxy’ checkbox and then

enter the address the proxy requires in the ‘Proxy address’ field. Your
support group will be able to tell you the address you should enter her
Also, ask them if you need to enter a specific port address.

IT

e.

Safeguard Viewer uses port 8444 or 443 to securely address (using HTTPS)

the relevant administration server for the publisher whose product you have

purchased (for internal systems this corresponds to the documents you are

authorized to use). If your internal system requires the use of a different

port for the connection you must enter it in the ‘Proxy port’ field.

The information for the server your publisher is using is displayed in th
license file and can be viewed with Windows Notepad or a similar
application.

If the URL is https://www.locklizard-license1.co.uk:8444/LockLizardLicensing (IP

e

address 82.165.43.29) then port 8444 is used for secure traffic and port 8080

for non-secure traffic.
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If the URL is https://www.locklizard-license2.co.uk/LockLizardLicensing (IP addr
87.106.7.187) then port 443 is used for secure traffic and port 80 for non-
secure traffic.

ess is

If your internal control system requires authentication at the firewall then

check the ‘Proxy Authentication’ checkbox and enter in the fields provided

the username and password that your IT department have allocated to

access the firewall service.

If you do not supply the Proxy authentication data (username/passwor
the proxy server requires authentication, a dialog box asking for the

d) but

username and password will be automatically displayed when Safeguard

Viewer tries to connect to the Internet.

If the "Use Proxy" check box is not checked, then the viewer will use th

e

Internet Explorer settings for the Internet connection (assuming the proxy

settings are defined in IE).

NOTE: Changing Settings
If the viewer is running whilst you have been adding or changing proxy settings then it
must be restarted (or the current document reopened) to apply the modified proxy

settings.

You only need to run the utility once unless someone decides to change your internal
proxy settings and they cannot be automatically picked up by the viewer software.

NOTE: Evaluating Lizard Safeguard

If you are evaluating Lizard Safeguard (free 15 day trial) then Safeguard Viewer uses
port 443 to securely address (using HTTPS) the LockLizard administration server.

The server URL is https://www.locklizard-license2.co.uk/LockLizardLicensing and the IP
address is 87.106.7.187
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1.5

Registering the Viewer license

license with your publisher.

IMPORTANT NOTE: Connection to the Internet is required

You must be online to the Internet during the registration process because it updates the

registration control service in real-time. If you do not have an Internet connection then

you will receive an error message and you will have to start the process again.

You must be logged on as a user with Windows Admin rights in order to register a license.

license file (YourName.llv) as in the example diagram below.

Before you can start viewing secure PDF documents you must first register your

You will have already been sent an email from your publisher containing your

i File Edit View

1 LockLizard Safeguard Secure PDF Viewer Registration - Message (HTML)

Insert Format Tools Actions Help Adobe PDF

i gReply | ‘QReplytoAll | ipFonward | J 3 [ w S M X e -v-a 5 0

(===

‘You forwarded this message on 30/07/2008 21:25,

Sent: Wed 30/07/2008 17:48

From: support@locklizard.com

To: info@locklizard. com
Ce:

Subject: Locklizard Safeguard Secure PDF Viewer Registration

Attachments: & ENIEEEL | ) test4.zip (407E)

Viewing LockLizard Safeguard Secure PDF Files

The following is your registration process allowing you to access documents protected by LockLizard.

A ou should only open attachments from a trustworthy source.

There are two steps: installing the viewer,

Installing the Viewer

Download and install the Viewer software.

1. Click on the following link: http://www.
2. Save the Safeguard PDFViewer program|
3. Double-click on the program to run the

Apple Mac users can download the Viewer s

http://www.locklizard.com/Downloads/PDCW

Opening Mail Attachment

-

k.

4

Attachment: test4.llv from LockLizard Safeguard Secure PDF
Viewer Registration - Message (HTML)

Would you like to open the file or save it to your computer?

)

Always ask before opening this type of file

[ Open

»

m

Diagram 10: Safeguard Viewer Registration Email and License file
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1.5.1 Immediate Registration

To register, double-click on the .llv file in your email application, select the
‘Open’ option, and then the OK button.

Double-clicking on the .llv file invokes the registration process and registers
you with the publisher. A message dialog confirms successful registration.

1.5.2 Save license file and then Register

Alternatively, you can right-click on the license file attachment and use the
‘save as’ or ‘save to disk’ option to save the license file to disk. You can then
double-click on the license file in Windows File Explorer to register.

1.5.3 Zipped license files and registration

The license file is also contained in a zip file so that it does not get stopped
or altered by firewalls, or corrupted by mail applications during
transmission.

If you cannot register using the .llv license file for any reason then use the
one contained in the zip file.

Double-click on the zip file in your email application, select the ‘Open It
option, and then the OK button. Then double-click on the .llv file (this file is
revealed when the unzip process has run).

NOTE: Firewalls may rename file extensions

Some firewall products may have renamed the zip file, and you may have to approve
running it to reveal the license file contents. Zone Alarm for example, renames zip files
with a .zm9 file extension. You can either double-click on this file and Zone Alarm will
run asking you whether you want to view the contents, or you can save the file to disk,
rename the file extension back to .zip, and then double-click on it.
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1.5.4

1.5.5

Web based email systems and registration

With web based email systems (where you view your emails through a web
browser) you will need to save the license file to disk before double-clicking
on it so that the license process can be executed locally.

Successful Registration

At registration time checks are made to see if your customer account exists,
when it becomes valid, and the documents / publications you are allowed to

access.

Once you have successfully registered, the following dialog is displayed:

Registration successful @

I.-”"_"“‘-.I Thank you. You have successfully registered for accessing protected
W documents created by LockLizard |

Support email address : support@locklizard.com

oK || Hep

Diagram 11: Successful registration message

You will now be able to view documents and publications you are licensed
for.

If you are not connected to the Internet at the point of registration then you
will receive an error message and you will have to start the process again.

IMPORTANT NOTE: Backup your license file
Please make sure you retain a copy of the license file in case you need to recover the

system after a disk crash, or when updating to a new system, when you will need to
register your license again.
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1.5.6

Registration issues and firewalls

Safeguard Viewer uses port 8444 or 443 to securely address (using HTTPS)
the relevant administration server for the publisher whose product you have
purchased. You must therefore make sure that if your company has a
hardware firewall in place, or you are running a software firewall, that port
8444 or 443 is opened.

The information for the server your publisher is using is displayed in the
license file and can be viewed with Windows Notepad or a similar
application.

If the URL is https://www.locklizard-licensel.co.uk:8444/LockLizardLicensing (IP
address 82.165.43.29) then port 8444 is used for secure traffic and port 8080
for non-secure traffic.

If the URL is https://www.locklizard-license2.co.uk/LockLizardLicensing (IP address is
87.106.7.187) then port 443 is used for secure traffic and port 80 for non-
secure traffic. If your license file says port 8444, then click on the following
URL https://www.locklizard-licensel.co.uk:8444/LockLizardLicensing/writer_admin.jsp
to find out if you can access this port.

If you see a LockLizard branded web page then port 8444 is open, and you
should be able to successfully register Safeguard Viewer. If you receive a
blank screen or a browser error message page (i.e. this page is unavailable or
cannot be displayed) then port 8444 is closed and you won’t be able to
register Safeguard Viewer.

NOTE FOR EVALUATORS:

If you are evaluating Lizard Safeguard then Safeguard Viewer uses port 443 to securely
address (using HTTPS) the LockLizard administration server. The server URL is
https://www.locklizard-license2.co.uk/LockLizardLicensing and the IP address is
87.106.7.187. You must therefore make sure that if your company has a hardware
firewall in place that port 443 is opened. This is the standard port number for a HTTPS
port so most likely it will already be open.
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1.5.7 Firewall messages displayed during registration

1.5.8

Some firewalls or anti-virus products may display the following message

window (or similar) during registration. This notifies you that Safeguard

Viewer is trying to access the Internet.

| ZoneAlarm Security Alert
7 REPEAT PROGRAM

PDCVIEWER.EXE is trying to access the
Internet.

| dentification: |k nion
Application: POCVIEWER.EXE
Destination |P: 24.45.224 22 DNS
Wiew Properties

More Information Available:

Thiz pragram has previouzsly asked far Intermet access.

SmartDefense Advisor

? Advice iz not yet available far this pragram.
Chooze below or click Mare Info for
azsistance.

[T Bemember this setting.

[ Allonny ] [ iDeny ]

N

Diagram 12: Firewall message window during registration

L #

You must check the box (remember this setting) and select the Allow button

(or the equivalent for your product) so that the viewer can connect to the

Internet and register your license.

The viewer will also need to connect to the Internet when you view a
document for the first time, and may need to connect on subsequent
occasions depending on the document controls set by the publisher.

Registering with a publisher more than once

The license file given to you by your publisher may be valid for installation

on one or several computers. Ifitis only valid for one installation then once

you have registered using that license file it cannot be used again.
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1.5.9

1.5.10

You can, however, re-use your license file more than once on the SAME

computer. For example, if you have had to reload the Windows Operating
System and re-install Safeguard Viewer then you can re-register using the
original license file from your publisher.

If you have purchased multiple documents and entered different user
information each time (for example, John Doe the first time and J Doe the
second time) then you will be sent a new license file. You will need to
register using this second license file so that you can access any documents
that you purchased with the second user name.

However, if you purchased multiple documents from and always entered the
same user information each time, then you will only need to register once.
You will automatically have access to all protected documents you have
purchased.

Registering with different publishers

If you have purchased protected documents from different publishers you
will need to get a viewer license from each publisher before you can access
their document(s). You do not need to install the viewer software again.

Messages displayed if you have not registered

If you try to view a protected PDF file before you have registered, the
following dialog box (or similar) is displayed.

Locklizard Safequard secure viewer ==

P

f h You are not authorized to view this protected document.

L7
Please purchase this from www.mycompanyname.com or email
sales@rmycompanyname.coem for more information

ok || Hep

Diagram 13: Registration required dialog
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Chapter 2:  Viewing Protected PDF Files

To view a protected PDF file (PDC file), double-click on it in Windows File

Explorer.

Favarite Links Name Date modified Type
fard %! Rbusguide.pdc 11/08/2006 14:03 PDC File
& POEfil (1] Jack's pdf.pdc 27/10/2006 22:11  PDCFile
= e 3] Jack's pdf-allcustomers- checkalways-noprint.pdc 30,/07/2007 16:41 PDC File
L 71 Jack's pdf-test.pdc 07/11/2006 2337 PDCFile
Fold 5 =] JoshuaFrankenstein.pdc 15/06/2007 23:00 PDC File
i |'.'i_, labelfarcourier.pde 30,/04/2007 19:22 PDC File
b Ou‘tfo.ok T 12| LockLizard - protecting your intellectual property.pdc 31/07/2007 18:26 PDC File
R0 hles 71| JUNOG_RRR.pdc 31/10/200613:20  PDCFile

Diagram 14: Windows File Explorer

The protected PDF file is decrypted and displayed in the Safeguard Viewer.

As an example, you might see something like this:

ma d secuen
] Fie  View Document  Help

™ 130 Creating your publisher acrount

B 111 Badding up andrecoverng the sysien
£ L 52 Configurng the License Enal message
=] 113 Changrg the Vsh Applcaton Sarver LAL

Lizard Safeguard

o Manwal

g 8 Rpviman 10 e Lkiuaroion

Administration Server

B33 Md o3 (b bl es|omE |~ o@D ks Locklizard
'.-.,@tua:nrts B

Mgopunt reeer pies Dotument: mever spires

Diagram 15: Safeguard Viewer with protected PDF document
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2.1

When you view a secure PDF document (PDC file) for the first time, the viewer

software will check if it has the correct key to view it. If it does not, the viewer
will check with your publisher’s administration server to see if you have been
granted access to the document (you MUST be connected to the Internet at
this point). If access is allowed then the decryption key is transparently relayed
from the publisher to the viewer and you will be able to view the document. If
not, a message will be displayed telling you how to contact the publisher in
order to purchase the document.

Firewall / anti-spyware messages displayed when viewing
documents

The first time you view a protected document your firewall / anti-spyware
product may display the message (or a similar one) below.

| ZoneAlarm Security Alert
i SUSPICIOUS BEHAVIOR

PDCVIEWER.EXE is attempting to
monitor user activities on this computer.
If allowed it may try to track or log
keystrokes (user input), mouse
movements/clicks, web sites visited, and
other user hehaviors

Application: FOCWIEWER.EXE
Wiew Properties

SmartDefense Advisor

? SmartDefense Adwvizor iz not available far this
alert type.

r Apply thiz zetting to all suspicious behaviorz
exhibited by this application

[ Sllow | [ iDeny:

N

Diagram 16: Software firewall message dialog

L
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2.2

Safeguard Viewer does NOT monitor mouse activity, characters entered, web

sites visited etc., on your computer. It just checks whether its own processes
are running and you have to allow it to do this in order to view protected
documents.

Check the box (apply this setting to all suspicious behaviors exhibited by this
application) and select the Allow button.

NOTE: Firewall Settings

If you select the Deny button then the viewer window will be minimized and the protected
document will not be displayed.

Viewer controls

Safeguard Viewer uses familiar document controls so you can simply navigate
your way around a document. Less familiar controls are explained below.

2.2.1 Searching for text

=
]

This option can be found from the Document > Find Text menu item or from

the " icon in the toolbar. NOTE: The find dialog can be resized.

" Find S|
Fird what: locklizard Find Al
Options
Start from: Direction:
[Eurrent Fage - 1 Up @ Down
[ Match caze
[ Match whole word anly
Show gearch results dialag [—— |

Diagram 17: Find dialog box
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2.2.2

If you want a list of the search results, select the ‘Show search results dialog’

checkbox. When the search has finished the following dialog box will be

displayed where you can select from individual instances of the word you

are searching for.

. Find

Find what: locklizard
Optionz
Start from;

[ Current Fage -
[ Match caze

[] b ateh whole waord anly
Show zearch results dialog

Find in all pages result;

Direction:

(=)

@ Down

g

Page Found

“erzion 2.5 - Revizien 1.14  www locklizard.com e
Lizard Safeguard Administration Server v2.6 - Revizion 1.14
% CONFIGURING THE locklizard LICENSIH
Lizard Safeguard Administration Server v2.6 - Revision 1.14
to carry out their own installation of the locklizard Safeguard Administr:
perform the deployment of the locklizard Administration System and sh

use the locklizard implementation service. -

2007 e

2007 e

4 LI L3 LA LA P ORI =

-

Diagram 18: Find results dialog

Page up / down controls

6 of 32

I4 4 P bl

You can navigate around a document by using the:

1. Page controls in the toolbar;

2. Page controls down the right-hand bottom side of the viewer scroll bar;

3. Scrolling with your mouse;

4. Page up/down keys on your keyboard.

These controls are also available from the Document menu.
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2.2.3 Document display size (zoom)

=) 100% | - &)

You can change the document display size in the toolbar by:

1. Selecting the minus or plus buttons;
2. Selecting a value from the pull-down list box;

3. Entering a custom value directly into the field. If you enter a value into

the field then you must press the enter button on your keyboard in order

for it to take effect.

The document display size can also be altered using the Zoom options off

the View menu.

2.2.4 Navigation buttons

o o

History navigation buttons (next and previous buttons) are available on the

toolbar and the vertical scrollbar. These are useful to use if the documents

you are viewing have links in them to other pages. Once you have pressed

on a link you can then use the previous button to go back to the page you

were previously viewing. The history cache will hold a maximum of 50

viewed pages.

2.2.5 Scrolling options

By default documents are displayed in continuous scrolling mode. If you

want to scroll one page at a time then select the Single Page option from the

View > Page Layout menu.

2.2.6 Viewing multiple pages (book format)

If you want to view pages side by side (just like in a book) then select the

Page Layout > Facing option from the View menu.
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You can adjust the document display size until you see the pages fully on the

screen.

2.2.7 Menu bar display

If you have unchecked the view menu bar option and the toolbar option and
would like the menu bar to re-appear then press the escape key (ESC) on
your keyboard.

2.2.8 Full screen mode
o
The combination keys Ctrl+L can be used to switch between full screen mode
and normal mode.

This option is also available from the View menu and by pressing the =)
button on the task bar.

Whilst in full screen mode, Ctrl+F can be used to display the find (search)
dialog.

2.2.9 Printing Controls

2

The page range edit box may contain any of the following:

a page range: e.g. 2-50

a single page number: e.g. 23

multiple page ranges: e.g. 2-50;65-90;110-135
multiple single pages: e.g. 23;34;45;67

P w N e

NOTE: Semicolon Spacers

Multiple page ranges and page numbers MUST be separated by a semicolon.

Lizard Safeguard Viewer manual v2.5 - Revision 1.26 ©2008 LockLizard Ltd Page 26 of 38 ﬁa lncu“zar“



2.2.10

The page range edit box will only accept:

1. numbers: 0to 9
2. the minus sign: - page range separator
3. semicolon: ; for distinguishing multiple ranges/pages

NOTE: Character separators

All other characters will be ignored including the comma as a separator.

The following example shows what you should enter in the page range edit
box to print the first 10 pages, the last 10 pages, and page 25 of a 210 page
document: 1-10;200-210;25

There is no special order between a single page and a page range, meaning
that they can be mixed. For example: 1-10;23;24 or 23;1-10;24. The only
difference between these two selections is the order in which the pages are
printed.

Opening Documents at last viewed page

If you are viewing a large document and would like the viewer to open the
document at the last viewed page then select the option ‘Remember Last
Page Viewed’ from the Document menu. The viewer will next open the
document at the page that was last displayed when the document was
closed.

You can deselect the ‘Remember Last Page Viewed’ option from the
Document menu if you no longer want this feature enabled.
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2.3 File Sizes supported

Safeguard Viewer supports files of up to 200Mb in size.

Since files are decrypted in memory file opening times will depend on your
computer environment.

Examples of expected timings for very large file size handling are given below.

CPU 0/s MemoryfFile size Load time

P4-2.6 GHz Win 2k 1Gb 200 Mb .75 minutes
P4-3.4 GHz Win XP Pro 1Gb 200 Mb .5 minutes
Celeron 1.3 Win XP Pro 512 Mb 200 Mb 4.5 minutes

These are not guaranteed timings but guidelines so that you have an indication
of anticipated opening times when attempting to handle very large scale
protected files, and the impact on slower machines or lower memory systems.

2.4  Program Updates

Once a week, Safeguard Viewer will check with the LockLizard Administration
server to see if any new updates are available. If updates are available, the
Viewer software will ask you whether you want to download and install the
new updates.

You can also check for updates on a more regular basis by using the ‘Check for
Program Updates’ option from the Help menu.
NOTE: Windows User Rights

In order to install any updates you will need the appropriate Windows user rights to
update the Windows Registry and the Safeguard Viewer program installation folder.
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2.5 Document controls

The publisher may have placed controls on the document that require you to
connect to the Internet whenever you want to use a document, or connect
occasionally, and the viewer will automatically enforce those controls.

The publisher may only have licensed you to view a document for a specific
number of times. If that is the case you must be connected to the Internet in

order to view the document.

You may or may not be able to print a document (the print icon therefore may
or may not be enabled) and/or printing may be limited to a number of copies.

When you print a document a watermark image or text may be displayed on

the printed document.

Details of when your account expires (if ever) and when the document you are
viewing expires (if ever) are displayed at the bottom of the viewer window in

the status bar.

Lizard Safeguard Viewer manual v2.5 - Revision 1.26 ©2008 LockLizard Ltd Page 29 of 38 ﬁa lncu“zar“



Chapter3:  Troubleshooting

3.1

This chapter covers error messages that may be encountered when you are using
Safeguard Viewer. This is split into four main areas: Installation, Registration,
Opening a Document and General FAQs.

An online knowledgebase system can be accessed at http://www.locklizard-

license.co.uk/support/index.php? m=knowledgebase& a=view. This contains

the latest troubleshooting information.

IMPORTANT NOTE — CONTACTING SUPPORT

If you encounter an error that is not detailed in this section then please contact your
publisher for support. Do not contact LockLizard support directly as you will be referred
back to your publisher.

Please use the ‘Contact Service Support’ option from the Help menu wherever possible so
that important version and machine details are given to your publisher.

Installation

3.1.1 When I go to install the viewer by double-clicking on the exe

file, it tells me the file is corrupted

This error message is displayed if you have not downloaded the complete
file. Delete the partially downloaded file and re-download the software.
Once you have done that, check the file size published on the web site and
compare it with the one you have locally on your disk to make sure it is the

same.
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Registration

3.2.1 Error Message “We cannot connect to the license server by

Internet. Please check that you are connected, or that a
firewall is not stopping this connection.”

This error message will be displayed if either a firewall or proxy is stopping
the Safeguard Viewer from getting to the Internet.

If you are behind a company firewall then your IT department may have to
configure the firewall to accept an outbound connection for the viewer
program pdcviewer.exe on the appropriate port and allow access to the
LockLizard licensing server.

The information for the server your publisher is using is displayed in the
license file and can be viewed with Windows Notepad or a similar
application. If the URL is https://www.locklizard-
licensel.co.uk:8444/LockLizardLicensing (IP address 82.165.43.29) then port
8444 is used for secure traffic and port 8080 for non-secure traffic. If the
URL is https://www.locklizard-license2.co.uk/LockLizardLicensing (IP address
is 87.106.7.187) then port 443 is used for secure traffic and port 80 for non-
secure traffic.

NOTE: Software Firewall

If you decide to disable your software firewall to register the viewer software then
remember you must reboot your computer before it will take effect (software firewalls
remain memory resident even after you disable them).

In the case of proxy servers, proxy settings are automatically picked up from
Internet Explorer by the viewer software but there may be occasions when
this information is incorrect or unavailable and you will have to manually
enter proxy settings in Safeguard viewer.

Off the Windows Start menu > Programs > Lizard Safeguard PDF Viewer >
Proxy Settings is where you enter this information. See proxy settings.
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3.2.2

3.2.3

3.2.4

3.2.5

Once you have registered the viewer it does not need the proxy settings

again unless someone decides to change your internal proxy settings.

When I go to register my license file it tells me “the server is
unavailable”

Please try registering again.

If the problem continues then the most likely reason for this is that you are
using a proxy to access the Internet. Make sure you have entered the
correct proxy settings and then try again. See proxy settings.

When trying to register I get the error message “License check
failed server returned 407 response code”

The most likely reason for this is that you are using a proxy to access the
Internet. Make sure you have entered the correct proxy settings and then
try again. See proxy settings.

Error message when registering: "License Check Failed. Server
Returned 302 Response code”

This message is displayed when the URL for the licensing server is redirected
by a proxy server. The most common reason for this message is that your
organization strictly controls access to web sites and the LockLizard Licensing
server has not been added to the authorized list.

Error message “Server Response code 504"

This error message is displayed if access to port 8444 is blocked. Safeguard
Viewer needs this port open so it can communicate with the server. Please
check with your company’s network engineers that this port is open.

If you are evaluating Lizard Safeguard then this error message is displayed if
access to port 8080 is blocked.
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3.2.6

3.2.7

3.2.8

3.2.9

The license file I have received has an extension of .mim not
Alv. I change it to .llv but still cannot register.

This is because you are using AOL or IM as an email client and AOL / IM has
corrupted the license file and changed the file extension.

Use the .llv file contained in the zip file instead. Save the zip file to disk,
unzip it and then double-click on the .llv file.

The requested URL_LockLizardLicensing_CheckLicense was
not found on this server (displayed if a proxy is running)

Can't connect to server www.locklizard-license.co.uk Error
12003. An extended error was returned from the server.

We cannot register your account because the server is not
available

The most likely cause for these error messages is that access to port 8444 is
blocked. Outbound and inbound traffic must be enabled on this port.

If your network administrator does not allow traffic on this port then you
can use port 8080 instead. To do this, edit the license file using Notepad and
change HTTPS to HTTP and port 8444 to port 8080 and save the file. Then
use the 'Remove Keystore' option from the Windows Start menu > Programs
> Lizard Safeguard PDF Viewer menu. Once you have done this, double-click
on the license file to register.

If the license file already uses port 8080 then please check with your
network administrator that inbound and outbound traffic is enabled on this
port.
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3.2.10 An error has occurred while retrieving document access Kkey.
Unexpected end of file from server.

The most likely reason for this is that the viewer is loosing packets due to a
poor or inconsistent Internet connection.

Open a DOS Command Prompt window and type:

ping -1 2000 -t www.locklizard-licensel.co.uk

NOTE: Server URL

You may have to replace the server URL with the server name you are connecting to,
since it may be different from the one above. If you are unsure, please ask your
publisher for the correct URL.

The command ping -1 2000 sends requests for packets of 2000 bytes, unlike
the basic ping command that only uses 32 bytes of data.

The command will display the response time and packets. If packets are
being lost, the viewer can't check with the server for license rights and the
decryption key can't be properly downloaded.

If this is the case you will need to check your connection and retry when it is
stable. Show this problem (the packets loss over a ping command) to your
ISP, or, if you are part of a private/company network, then you need to get
the network administrator to fix this problem.
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3.3 Viewing protected PDFs

3.3.1

3.3.2

IMPORTANT NOTE: Print Screen

When the viewer is running Windows print screen is disabled by default and cannot be
used by any programs whilst the viewer remains active.

If you are running a ‘screen grabber’ application you may be asked to close it whilst the
viewer remains active.

Error message “You do not have the correct key that is
required to decrypt this document” is displayed but you have
been given access to the document.

The most likely reason for this error message is that the file is incomplete
(partial download). Please compare the file size of the PDC file against the
file size listed on the publisher’s server. If this information is not available
then please ask your publisher for it.

If the file size is incorrect then you will need to re-download the PDC file.

Error message "Acrobat could not open "<filename>.pdc"
because it is either not a supported file type or the file has
been corrupted”

This error message is displayed if you try and open a .pdc file directly from
Adobe’s File Open menu or you have associated the .pdc file extension with
Adobe Acrobat.

To open a .pdc file you must double-click on the filename in Windows File
Explorer or right-click on the file and select ‘Open With PDCViewer’.
Alternatively, you can open a PDC file from the Safeguard Viewer File Open

menu.
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3.3.3

3.3.4

Error message "You need to register with the publisher before
you can view any protected documents”

Before you can view protected documents you must first double-click on the
license file sent to you by your publisher in order to register.

If you have done this and this message still appears then the most likely
reason is that you tried to register the viewer software over a VPN which will
not work - you MUST have a direct Internet connection.

Delete the keystore (off the Windows Start menu select Programs > Lizard
Safeguard PDF Viewer > Remove Keystore) and then try registering again,
this time using a direct connection to the Internet.

Error 1284:68. Can't connect to server www.locklizard-
licensel.co.uk. Error 0. The server response could not be
parsed. Please check your internet connection and try again

This message is displayed if the server response is truncated (the data sent
from the server gets corrupted). This could be because:

1) The license file has been corrupted. Obtain a new license file from your
publisher or register using the one contained in the zip file. Before
registering again you will need to delete your keystore (off the Windows
Start menu select Programs > Lizard Safeguard PDF Viewer > Remove
Keystore). Once you have done this double-click on the license file to
register.

2) A proxy is in use and proxy settings have not been configured in the
viewer software. See proxy settings.
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3.4 General FAQs

3.4.1 Dol have to be connected to the Internet in order to view
secure PDF documents?

This depends on the controls set by the publisher. They may require that

you connect to the Internet every time you view one of their documents, or

that you connect every n number of days, or that you don’t need to connect

to the Internet at all.

If the publisher has limited the number of times you can print a document

then you will be required to connect to the Internet each time you attempt

to print.

3.4.2 Where do I buy a license from to view protected PDF
documents?

From the relevant publisher. If you do not have a license for a .pdc file the

viewer will display a message from the publisher telling you how to contact

them.

3.4.3 What happens when I change or upgrade my computer - Do I

need a new license?

3.4.4 Upgrading Computers

Safeguard Viewer can be re-installed on the same computer without you

having to request an additional license from your publisher. When you re-

register with the old license details, the viewer software checks with the

administration server certain details and lets the license be re-used. So if

you re-install your operating system or change your hard disk drive for

whatever reason you can re-install Safeguard Viewer, re-register with your

old license information and continue using the product as before.
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3.4.5

3.4.6

3.4.7

Changing Computers

If you change computers then you will need to ask your publisher for
another license so that you can install the viewer software and register
again.

How do I open a PDC document directly from Internet Explorer
or any other browser?

If you click on a link to a PDC file from Internet Explorer, you are asked to
Open or Save the file. To view the document, select the Open option.
Internet Explorer will then call the Safeguard viewer to display the PDC file.
To get Internet Explorer to automatically call the viewer to display the PDC
file every time you click on a PDC file link, uncheck the option "always ask
me before opening this type of file".

What is the remove keystore option for?

On rare occasions, security information may be corrupted, and it is
necessary to regenerate that information. To cause this to happen you use
this feature to remove the existing faulty keystore, and then re-register your
license with your publisher.

The remove keystore utility is located in the LockLizard Safeguard Viewer
program group off the Windows start menu — Start > All Programs >
LockLizard > Lizard Safeguard > PDF Viewer > Remove Keystore.
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